Montana Tech Faculty Senate
Meeting Minutes
November 12t 2025 « Mill 201 ¢ 12:00 p.m.
Senators in attendance included Scott Risser, Janet Cornish, Foued Badrouchi, Brahma Pramanik,
Chris Roos, Charie Faught, Courtney Young, Atish Mitra, Bryce Hill, Doug Galarus, Chris Gammons,
Naim Rashid, David Gilkey, Matt Egloff and Jason Herndon. Guests attending the meeting
included Provost Tim Elgren; Michele Hardy, Dean of CLSPS; Tammy Burke, Dean of Highlands
College; Kristel Koukoua, Center for Academic Innovation and Shauna Goodell, Student Affairs.

I. Welcome and Minutes — The meeting commenced at 12:00 p.m. and a quorum was
established. Senator Egloff moved, and Senator Hill seconded a motion to adopt the minutes
of October 29t 2025. The motion carried.

Il. Reserved — Senator Rashid moved, and Senator Mitra seconded a motion to amend the
agenda to allow for the consideration a request to confer the title of Professor Emeritus of
Environmental Engineering upon Dr. Kumar Ganesan. (See attached.) The motion carried. Dr.
Ganesan will retire in December of 2025. Following the Faculty Senate’s action the matter
will be considered by the Board of Regents. Senator Egloff moved, and Senator Gilvey
seconded a motion to recommend Dr. Ganesan for Emeritus status. Senator Young
commented that the title of Emeritus was well-deserved. The motion carried.

lll. Committee Reports — Senator Roos reported that the Curriculum Committee had not yet
received any proposals from Department Heads and urged everyone to submit their proposals
to the Committee prior to its next meeting, which will be held on Monday, November 24t at
1:00 p.m.

Senator Risser reported that the Chancelor’s Cabinet has amended the proposed Policy for
Naming of Buildings (attached to these minutes) in response to the concerns raised by the
Faculty Senate. In an effort to streamline the policy-making process and to make it more
collaborative, the Cabinet asks that, in the future, the Faculty Senate review the policies and
then do one of two things:

a. Accept those provisions with which it agrees (as written)

b. Offer new language that would be acceptable for items if finds concerning

The Employee Relations Committee (ERC) has prepared a draft Professionalism Statement
(attached to these minutes) for the Senate’s review. The ERC includes both faculty and staff
members, including Senator Young, who noted that the Statement would also be reviewed in
light of the Chancellor’s Culture Statement for Montana Tech. Provost Elgren explained that
the Statement had also been discussed in the collective bargaining process and would be
further considered by the Labor Relations Committee. The various versions would ultimately
be reconciled.

IV. Faculty Workload — Senator Gilkey, explained that, in response to an incident regarding the
hiring of a retired faculty member, it became apparent that Montana Technological University
had no consistent policy regarding faculty course assignments. Particularly, he pointed to
whether full-time faculty had the right of first refusal (before a part-time or adjunct instructor
was considered) when a new course was being offered. Senator Egloff thought it would be a



good idea. Senator Cornish, representing the Writing Program noted that such a policy would
be difficult to implement given financial limitations. She also noted that it was important for
Department Heads to maintain the administrative authority to select whatever instructor was
best for a particular course.

Tammy Burke, Dean of Highlands College, explained that the College did have a policy under
which full time faculty did not have the right of first refusal. She explained that at Highlands
a three-credit course may have many more contact hours than the number of credits would
imply; additional course assignments may be too much for full-time faculty to manage.

Senator Gilkey noted that most faculty members do not want to teach additional classes. He
asked that Senators take this issue back to their respective Department for discussion. No
action was taken.

Request from the Writing Program Regarding Course Material Accessibility — The Writing
Department is currently working on making its course materials accessible in compliance with
University requirements, by April of 2026. In association with this effort, the Department has
generated a wish list (shown below in italics), which the writing faculty shared with the Faculty
Senate. Kristel Koukoua, Center for Academic Innovation and Shauna Goodell, Student
Affairs responded to each of the items as follows:

a. A fully accessible Canvas template. Kristel has placed a template in the “Syllabus”
tab on Canvas, which is downloadable with a statement as described under “c”
below.

b. A check box built into the Canvas template that says something along the lines of,
"I have read the agree to the accessibility statement presented on the syllabus." It
would be nice if Kristel/Shauna/Jennifer  could compose that
accessibility statement and present it right at the top of the Canvas course shell
landing page so that it's a built-in feature. Kristel is working on this.

c. A standardized accessibility statement that can go onto every syllabus that asks
students to contact the instructor if they need further assistance with accessible
course materials beyond that already provided. (see “a”, above)

d. An accessible Microsoft Word syllabus template; many folks on campus do not use
Google Docs (a syllabus template was recently sent out in that format). Kristel
noted that the templates she uses are not taken from Google Docs.

e. A straightforward accessibility checklist that includes the simple fixes faculty can
apply to their Microsoft Word and PowerPoint documents from the start to help
make them accessible on Canvas. Shauna provided the checklist, which is attached
to these minutes.

f. To bring the acceptable Canvas accessibility score down to 60-65% (from 70
percent) if possible. Kristel explained that this was not possible. However, she is
working with Panorama to make the software less strict regarding certain issues.
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VI.

VII.

VIII.

For example, Panorama would not flag documents for smaller fonts used in super-
or subscript formats.

Senator Faught asked whether the score was per item or in the aggregate. Kristel explained
that it was a peritem score, and we had to work to achieve a green icon for each one. Senator
Faught pointed out that achieving greater accessibility was a “heavier load” for faculty
members teaching on-line courses.

Senator Mitra asked about accessibility associated with electronic white boards and Senator
Egloff noted that there were some ongoing technical issues with smartboards in general.
Senator Cornish commented on the need for accessible templates for PowerPoint ©
presentations. Kristel is working on the templates and intends to provide more assistance
and training on a departmental basis to address issues such as accessibility for smartboards.

Senator Pramanik asked about sharing links to One Drive. Kristel suggested that if One Drive
documents were not accessible, they could be made so using Panorama or the instructor
could provide a note to students asking them to alert the instructor of the need for an
accessible version.

Course Evaluations — Senator Risser explained that the next step in developing course
evaluations was to consider the platform we would use, what we must have with respect to
the design of the evaluations (such as making them accessible) and any preferences beyond
the “must haves”. Senator Egloff asked how this effort would affect the existing work. Senator
Risser explained this was more about the delivery rather than the content. Senator Egloff
noted the low response rate currently. With respect to platforms, Senator Risser noted that
there were many examples to draw from. The group working on this needs more volunteers;
no one representing CLSPS is currently in the group. Senators Roos and Herndon both
volunteered to help.

Full Faculty Meeting — Senator Risser suggested the following options, given that we had poor
attendance at the Spring 2025 meeting. The options include:

Cancel the full-faculty meeting entirely

Use Senate funds to hold a social event

Host a 30-minute presentation on Chancellor’s “Four-Lane” project

Host a series of round table workshops.

Senator Cornlsh suggested we might focus on accessibility, where faculty members, working
with Kristel and Shauna could share and learn and offer treats. Provost Elgren discussed
specific types of accessibility training for the STEM courses.

o0 oo

For the Good of the Order — Senator Risser noted this was our last regular Faculty Senate
Meeting for the Fall 2025 semester and would begin planning Spring 2026 Semester meetings,
based on everyone’s schedules as indicated in Outlook. Senator Young moved, and Senator
Cornish seconded a motion to adjourn at 1:00 p.m.
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11/11/2025.
Authorization to Confer the Title of Professor Emeritus of Environmental Engineering; Montana
Technological University

THAT
Upon the occasion of the retirement of Dr. Kumar Ganesan from the faculty of Montana
Technological University, the faculty wishes to express its appreciation for his years of dedicated
and valued service to the institution, the Department of Environmental Engineering, and the state
of Montana by recommending the rank of Professor Emeritus in the Department of Environmental
Engineering be conferred upon him by the Board of Regents of the Montana University System.

EXPLANATION
Professor Ganesan began his career at Montana Tech in 1983 as an Assistant Professor of
Environmental Engineering and became a full Professor in 1992. In 1996, he was appointed
Department Head, a position he held for 29 years. He holds a BS in Civil Engineering and an
MSc in Public Health Engineering from India. Prior to joining Montana Tech, he worked as a
Scientist at NEERI, a leading Environmental Engineering Research Institute in India, for six
years. He earned his doctoral degree in 1981 from Washington State University (WSU),
Pullman, Washington, and subsequently worked for a research consulting company before
moving to Montana Tech.

During his tenure at Montana Tech, Dr. Ganesan received numerous accolades, including
multiple faculty achievement awards, the distinguished researcher award, the lifetime
distinguished researcher award, and Montana Tech's Mentor of the Decade award for his
exceptional mentorship of graduate students. He is a long-standing member of the Air and
Waste Management Association (AWMA), an international professional organization, where
he served as president of the Regional Organization (AWMA-PNW!IS) and received the
Robert Stockman Distinguished Award for his contributions to Air Pollution Engineering. He
is currently a Board of Director of AWMA and holds the title of "Fellow" within the
organization. In 2011, AWMA honored him with the Lyman Ripperton Environmental
Educator Award for inspiring students to excel professionally and socially while teaching
with enthusiasm, humor, humility, and pride.

Dr. Ganesan has also received faculty fellowships from US AID, US DOE, and AAAS/US EPA.
In 1999, he founded the Center for Environmental Remediation and Assessment (CERA) and
served as Director of the Montana US EPA-EPSCoR program. He initiated an NSF-EPSCoR-
funded Biomedical Engineering initiative, collaborating with cardiac surgeons from the
International Heart Institute (IHI) in Missoula, Montana, which led to five graduate students
completing research on heart valves. Additionally, he served as an ABET Accreditation
program evaluator for over a decade. He served as the Director of the MPEM online degree
program at Montana Tech from its inception in 1998 until 2022.

Dr. Ganesan has an extensive portfolio of technical publications, conference presentations,
technical reports, and has authored and co-authored five books.
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Dr. Ganesan’s tenure at Montana Tech can be characterized as outstanding with
significant service to the University and to the State for which he is to be commended. For
these and numerous other contributions, the Department of Environmental Engineering is
honored to nominate Dr. Kumar Ganesan for the rank of Professor Emeritus of
Environmental Engineering at Montana Technological University.
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Montana Technological University
Naming of Property, Programs, and
Campus Areas

Subject:
Section 1000 - Physical Plant

Number:
1004

Effective date:
November 1, 2025

Review date:
November 1, 2028

Responsible Party:
Vice Chancellor of Administration and Finance

Historical versions: Link if applicable.

Introduction and Purpose:

This policy governs the naming of Montana Technological University property,
programs, and campus areas per Montana Board of Regents Policy 1004.1.

Authority:

The Vice Chancellor of Administration and Finance is responsible for managing this
policy and for maintaining procedures related to this policy.

University Policy:

The Board of Regents of the Montana University System considers the naming of
property, programs, and campus areas in honor of a living or deceased individual,
corporation, foundation, or organization to be one of the highest and most distinct
honors that it can bestow. All naming honors by and for Montana Technological
University shall be in accordance with BOR Policy 1004.1.

I. All requests for naming buildings, colleges, schools, departments, centers,
athletic stadiums, athletic fields, auditoriums, and theaters with seating for
500 or more, and campus areas which have historic distinction to the campus
must first be submitted to the Vice Chancellor for Administration and Finance
for review and guidance. The proposal will then be submitted to the
Chancellor of Montana Technological University. If approved, the Chancellor
will submit the proposal to the President of the University of Montana whom,
if approved, will submit to the Montana Board of Regents for final approval.
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https://mus.edu/borpol/bor1000/1004-1.pdf
https://mus.edu/borpol/bor1000/1004-1.pdf

I1.

I1I.

IV.

VI.

All proposals for naming classrooms, conference rooms, auditoriums, and
theatres of less than 500 capacity, internal libraries, rooms, hallways, floors,
and features, as well as other enclosed or conditioned space(s) within
buildings shall be submitted first to the Vice Chancellor of Administration for
review and guidance; and then to the Chancellor for approval, with
agreement by the President of the University of Montana.

All proposals for naming academic programs or units subordinate to colleges,
schools, departments, and centers, shall follow the procedures outlined in the
Academic Affairs Procedural Guidebook, and they shall be submitted to the
Provost and Executive Vice Chancellor for review and guidance, Proposals
shall be submitted to the Chancellor for approval, with agreement by the
President of the University of Montana.

Per BOR Policy 1004.1 Naming Honors shall specify the term that the name
will exist or specify that it is in perpetuity. Perpetuity means the useful life of
the property or program or as long as the program or property has not
substantially changed. Naming in perpetuity should only be considered for
transformative gifts. Exceptions may exist and must be approved by the
Board.

Per BOR Policy 1004.1, where naming authority lies with the Board, the
Board may remove the name under certain circumstances. The Chancellor or
University of Montana President, where naming authority lies with the
Chancellor or University of Montana President, may remove the name under
the same circumstances as listed in BOR Policy 1004.1.

Naming a property or program based on a charitable gift to the campus shall
be done in accordance with the Montana Technological University Foundation
Gift Acceptance Policy as approved by the Montana Technological University
Cabinet.

Procedures:

The Vice Chancellor for Administration and Finance will manage all haming requests
for property and shall establish procedures accordingly. The Provost and Executive
Vice Chancellor will manage all naming requests for academic programs and shall
establish procedures accordingly. All procedures shall include discussion and
feedback from appropriate shared governance bodies and shall align with existing
campus processes governing academic changes.

Adopted by: (Chancellor) Date
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Professionalism for entire campus, including faculty, staff, and students

Professional behavior refers to the set of attitudes, actions, and standards expected of
someone in a professional or workplace setting. It encompasses how individuals conduct
themselves to demonstrate respect, competence, reliability, and integrity in their role.
Standards of professional behavior apply to all Montana Tech employees, including
administrators, faculty, staff, and student employees.

Key Elements of Professional Behavior:

1. Respect

o

o

Treating everyone with courtesy, dignity, and civility
Being aware of differences in culture and ability

2. Accountability and Dependability

o

o

o

o

Taking responsibility for one's actions and decisions

Meeting deadlines and fulfilling commitments

Being punctual and reliable

Owning mistakes and working to correct them without deflecting blame

3. Integrity and Ethics

o

o

o

o

Practicing honesty, fairness, and transparency in all interactions

Treating all individuals equitably regardless of role, background, or belief
Demonstrating respect for and adhering to all applicable laws, policies, and
procedures

Avoiding conflicts of interest or unethical practices

Maintaining confidentiality and privacy when appropriate

Communicating transparently when sharing one’s views that those views are not
those of the University

Conforming to the highest ethical standards of one’s profession

4. Competence and Professional Development

Demonstrating the standards, skills, and knowledge required of one’s profession
Maintaining credentials required by one’s profession

Pursuing opportunities for continued learning and development

Accepting constructive feedback positively

Staying current with technological and procedural advancements

5. Communication Skills

o O O O

o

Listening actively and valuing different perspectives
Speaking and writing clearly and professionally

Using respectful and appropriate tone and language
Avoiding discriminatory or inappropriate speech

Being mindful of nonverbal cues

Practicing appropriate digital communication etiquette

6. Appearance and Presentation

o

o

o

Dressing appropriately for the work environment
Maintaining personal hygiene
Representing the organization well in public or professional settings

7. Interpersonal Relations
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o Maintaining and demonstrating collaborative, empathetic, and unbiased
demeanor

o Handling conflict in a calm, courteous, and constructive manner
Avoiding negative commentary and behaviors such as vindictiveness and

retaliation

o Practicing appropriate interaction and language and being mindful of perso
space

o Being flexible and willing to compromise when priorities shift or assistance
needed

Everyone is expected to understand and adhere to these key elements of professional
behavior. The following governing policies and procedures must also be understood and
adhered to including but not necessarily limited to:

Board of Regents https://mus.edu/board

Montana University System https://mus.edu

Campus Safety https://www.mtech.edu/campus-safety

FERPA https://studentprivacy.ed.gov/ferpa

Title IX https://www.ed.gov/laws-and-policy/civil-rights-laws/title-ix-and-sex-
discrimination

Title VIl https://www.eeoc.gov/statutes/title-vii-civil-rights-act-1964

Collective Bargaining Agreements https://www.mus.edu/hr/cba/collbarg.html
Faculty / Staff Handbook https://www.mtech.edu/facultystaff/fac-staff-handbook-

acc.pdf
Montana Code Annotated https://archive.legmt.gov/bills/mca/index.html

Administrative Rules of Montana https://rules.mt.gov/

Contact the office of Human Resources when the need arises:
https://www.mtech.edu/about/admin-services/human-resources/

nal

is
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CHAX WCAG 2.1 for PDF

Accessibility Training

< A Tamman Group >

Basics in Plain English

11 Text Alternatives - No Images 1.3.4 Orientation - Make sure your content
of text without a text alternative. doesn't lose read order or structure
However, Stuffing 150 words into if the user decides to reflow the
the Alt-text field for a screenshot document or change the orientation
would not be appropriate. when possible. (AA)

111 Non-Text Content - If there is 1.41 Use of Color - Do not use color as
an image, chart or graph, provide the only way to tell the difference
meaningful alt-text that tells the between two or more objects. (A)
same story. (A}

1.4.3 Contrast Minimum - Text must

1.3 Adaptable - Do not force the have enough contrast to be read
user to interpret the PDF in only against the background color.
one way. 4.5to 1 for regular text (14pt

and below) and 3:1 for large

1.31 Info and Relationships - The text (14pt and Bold or 18pt and
visual representation must match above). Logotype and incidental
the tag. Heading, List, Graphic, (background) text are excluded
Table, etc. (A) from this requirement. (AA)

1.3.2 Meaningful Sequence - If it 1.4.4 Resize Text - If you have low-res
matters what order things are in, images of text and they are so
make sure your tags and reading blurry at 200% you cannot read
order follow that sequence. (A) them, you fail this criteria. (AA)

1.3.3 Sensory Characteristics - Do 1.4.10 Reflow - Content must maintain

not use an attribute that cannot
be interpreted by a screen reader
as the ONLY way to differentiate
it from other objects like color,

orientation, text size, etc. Example:

Items in red are 50% off. (A)

accessibilityUnraveled.com

structure and info even if
document s put in reflow

(Acrobat: View > Zoom > Reflow or

Control+4) This new requirement
is what supports setting the Order
(Read Order). (AA)

training@accessibilityUnraveled.com
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1411

1.4.12

21.2

24.2

2.4.3

2.4.4

Non-Text Contrast - Objects that
have visual meaning (graphical
objects) containing a fill color or
stroke color must have enough
contrast (3:1) to be individually
identifiable. (AA)

Text Spacing - Does not apply
to PDFs. It’s about webpages. (AA)

Keyboard - The document
must allow a user access to

all the meaningful information
via keyboard controls without
a mouse. (A)

No Keyboard Trap - Avoid pop ups
and other dynamic content that
can cause a user to be “stuck” in a
window they cannot get out of or
that does not allow them back to
where they were. (A)

Page Titled - Make sure your
document has a descriptive title. Set
your document title in Acrobat File
> Properties > Description. (A)

Focus Order - This is a companion
to 1.3.2 Meaningful Sequence and
supports setting the Order

(read order) panel. (A)

Link Purpose in Context - Make
your links descriptive. Avoid “Click
Here.” or "More Info.” "More about
WCAG" would be better. (A)

Al

Adobe

CERTIFIED INSTRUCTOR

2.4.6

3141

3.1.2

41

411

41.2

Visit accessibilityUnraveled.com for training courses and more.

Headings and Labels - Headings
should be sufficiently descriptive.

A Heading titled “Chapter 1”

would not be sufficient. “Chapter 1 -
Introduction” would be better. (AA)

Language of a Page - The default
language should be set for your
document. File > Properties >
Advanced > Language. (A)

Language of Parts - Set the
language attribute for phrases or
words not in the base language of
the document. (AA)

Compatible - Your document
must be able to be read by current
and future programs, not just
NVDA and JAWS.

Parsing - Your tag structure and
your formatting should be correct.
This is particularly important for
things like TOC, Lists, annotations
and other items that require a
specific nesting order (one tag or
structure inside another). (A)

Name, Role, Value - Form fields,
links, and other interactive elements
can be properly identified as
checkbox, button, form field etc.
and have meaningful tool tips. (A)

()

CHAN Chat
PODCAST
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10 Things you can do to improve
accessibility without being an expert!

training@accessibilityunraveled.com
Youtube & Facebook: PDF Accessibility

Training &

Consulting

ACCESSIBILITY UNRAVELED

We hear it all the time. Accessibility is too hard! You have to be an expert! The truth is there are lots of things
you can do to improve the accessibility of your document and digital content. Accessibility starts with small
steps. Use these 10 simple actions to improve your content. You might be surprised at how easy it can be.

o Title your Documents

Choose a meaningful title that identifies the
document or its content.

Describe your images

It is pretty easy to right click on an image and
enter a descriptive sentence or two. Answer
the questions "What is important in this
image? What do they need to know?"

Use Headings

Headings are anchors or outline levels for
content that people using assistive technology
use to navigate by. Keep your headings logical
and in order. Heading Level 1, Heading Level
2, etc. Headings make your document more
readable for everyone.

Avoid excessive bullet levels

Every list level change is announced by a
screen reader. Imagine having to keep track of
where you are when you hear “List Level 1, List
Level 2, List Level 3, List Level 2, List Level 3,
List Level 4, List Level 3"

o Use descriptive links

Use meaningful link text instead of “Click Here"

or long URLs. "Download the Checklist” is far
more accessible than download http://www.

accessibilityunraveled.com/content/PDFs/
Checklists/MSWord 071222.PDF

o Avoid images of text

Images may make our text look fancy with
drop shadows and bevels or highlights but
screen readers cannot detect the text inside a
jpg or png. If you forget to add descriptive text
sometimes title,jpg is all the user gets for a
description.

#accessibilityMatters

o Keep tables simple
This is a much deeper subject but at its core,

keep your tables simple. Heading rows at the
top or in the first column instead of using them
to visually separate rows of content will make
your table much more accessible without any
heavy accessibility work in the PDF.

Avoid faded color schemes

People with low vision are a substantial
portion of those with disabilities. Use darker
colors for headings and meaningful content.
Avoid pastels, faded colors, oranges or yellows
for headings as they can be hard to see.

o Avoid red and green indicators
As many as 1in 8 males are Colorblind. Avoid
using red or green as differentiators. Example:
“Items in red are required” If you have to
use them consider adding a symbol or other
method to help differentiate them.

Use simple language

Use plain language when possible. It will
improve the reading rate for everyone. In item
9 we used “differentiate We could have used
“tell them apart” to be more accessible!

CHAX Chat
PODCAST

Accessibility Unraveled

For more tips and accessibility chat
listen to our podcast on all major
streaming platforms: Ally Podcast

Accessible Podcast Transcripts at chaxchat.com

www.accessibilityUnraveled.com
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